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1.0 Introduction 

1.1 About This Manual 

The 131S/132S Gas Chromatograph uses the Envent ICE software for configuration, calibration, and 
reporting. To install the ICE Software, refer to the installer which comes in a USB flash drive supplied 
with the analyzer. If the USB flash drive is missing or damaged, contact Envent Support for access to 
the software. 
 
This manual will cover only basic operation and configuration of the gas chromatograph. Any 
advanced configuration items are not covered; if the user wishes to perform an operation not covered 
in this manual, please contact Envent Support. 
 
This manual will be referring to models 131S and 132S. However, the information applies equally to 
the 131S-T4 and 132S-T4, unless otherwise stated. 
 

1.2 Warranty and Liability Statements 

 
Products produced and supplied by the manufacturer (Envent Engineering Ltd), unless otherwise 
stated, are warranted against defects in materials and workmanship for up to 18 months from the 
shipping date or up to 12 months from the start-up date (whichever comes first). During the warranty 
period the manufacturer can choose to either repair or replace products which prove to be defective. 
The manufacturer or its representative can provide warranty service at the buyer's facility only upon 
prior agreement. In all cases, the buyer has the option of returning the product for warranty service to 
a service facility designated by the manufacturer or its representative. The buyer shall prepay all 
shipping charges for products returned to a service facility. The manufacturer or its representative 
shall pay all shipping charges for the return of products to the buyer. The buyer may also be required 
to pay round-trip travel expenses and labour charges (at prevailing labour rates) if the warranty has 
been violated. The warranty may be considered violated for any of the reasons listed below. 
 
1.2.1 Limitation of Warranty 

The foregoing warranty shall not apply to defects arising from: 
 

 Improper or inadequate maintenance of the product by the user 
 Improper unpacking or installation procedures 
 Inadequate site preparation 
 Unauthorized modification or misuse of the product 
 Operation of the product in unfavorable environments such as at high temperatures, high 

humidity, or in corrosive atmospheres 
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 Operation of the product outside of the published specifications 
 
Envent Engineering Ltd carries no responsibility for damage caused during transportation or 
unpacking, unless otherwise specified in the incoterms. 
 
An extended warranty may be available with certified start-up. Contact Envent Engineering Ltd for 
details. 
 
Envent Engineering Ltd reserves the right to change the product design and specifications at any time 
without prior notice. 
 
1.2.2 Disclaimer 

No other warranty is expressed or implied. The manufacturer specially disclaims the implied 
warranties of merchantability and fitness for a particular purpose. The sole remedy of the buyer shall 
in no case exceed the purchase price of the analyzer. The manufacturer shall not be liable for personal 
injury or property damage suffered in servicing the product. The product should not be modified or 
repaired in any manner differing from procedures established by the manufacturer.  
 

1.2.3 Software Revisions 

This edition of the software manual deals only with software edition ICE 9.1 or later. For assistance 
with earlier revisions of the software (Edition 8.8 or 7.3) contact Envent Support.  
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2.0 Using the Software Functions 

Most of the functionality in the ICE software will be familiar to users who are already familiar with 
Microsoft Windows applications and programs. The sections below will describe some of the software 
functionality.  
 
The menus have underlines on some of the letters, these indicate hot keys which can quickly access 
menu items. To use the hot keys, use the “Alt” key and press the letter underlined. For example, “Alt + 
F” will open the file menu, then continuing to hold Alt and pressing “N” will open the new file 
dialogue. 
 

2.1 Overview 

Below is an overview showing all the basic parts of the ICE software. The user should become familiar 
with these sections and what each does. Each section will have a portion of this manual dedicated to 
it in more detail. 
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2.2 File Menu 

File 
New… Opens the new device dialogue menu 
Open… Opens a saved “.device” configuration file 
Chart… Opens a saved “.chart” chromatogram file 
Close Closes the current configuration file 
Save Saves the current configuration file to the previously defined save 

location. If no save location has been defined, this will open the “Save 
As…” dialogue box 

Save As… Opens the Windows “Save As…” dialogue box. This is used to save a 
current device file 

Import Device Config… [Advanced use only] this option will allow the user to import an older 
firmware configuration to a newer firmware configuration 

Device Programmer… [Advanced use only] the device programmer allows the user to upload a 
firmware revision to the analyzer 

Printer Setup… Opens the Windows printer setup 
Page Setup… Opens the Windows page setup 
Exit Exits the software 

 

2.3 View Menu 

View 
Preferences… Allows the user to change software preferences such as the time units, 

chart preferences, and temperature/pressure units displayed 
Serial Port Setup… Allows the user to adjust the timing on the serial port 
Reporting… Opens a dialogue box which can adjust the various views and reports 

that the software outputs 
 

2.4 Network Menu 

Network 
Add New… Opens a dialogue menu for the user to add a new networked device 
Scan Network Scans the currently connected sub-network for new devices 
Clear Scanned List Clears the below list of previously scanned, or added, devices 
[Network List] Displays a list of all the network devices the software has scanned or 

added since the last time the list was cleared. Note: these devices may, 
or may not, be currently connected to the network. 

 



Envent Engineering Ltd – 131S & 132S Software Manual – Revision 1  Page 5 
 

2.5 Options Menu 

Options 
Formatting Opens the report formatting dialogue – same functionality as the View > 

Reporting… option 
Modcom [Advanced use] ICE built-in modbus simulation tool 
GPA Calculations [Advanced use] ICE built-in GPA calculation tool 
GPA Component Builder [Advanced use] More advanced GPA component building and 

calculation tool 
 

2.6 Help Menu 

Help 
About Displays the about information for Envent ICE 
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2.7 Icon Bar 

The icon bar contains icons which will be frequently used during operation of the software. Refer to 
this section of the manual when navigating the software and its functionality. 
 

Select Communication Port 

 
 

Opens a drop-down menu which is used to select the port on which 
to communicate with the analyzer 

Connect/Disconnect Device 

 
 

Connects or disconnects the currently selected device 

Read from device 

 
 

Reads the device file from the currently connected device 

Write to device 

 
 

Writes the currently open device file to the currently connected 
device 

Synchronize Clock with PC 

 
 

Clicking this button will immediately synchronize the real-time 
clock (RTC) on the analyzer with the system clock on the currently 
connected PC 

Address of Connected Device 

 
 

Allows the user to define which address to connect to. 255 allows 
ICE to connect to any device address 

Enable/Disable Information 
Popups 

 
 

Clicking this button shows contextual information popups when 
fields in Envent ICE are pointed at with the mouse cursor 
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2.8 Saving a Device File 

At times it may be necessary to save the current device configuration. These should be stored for 
future reference, or in the case an Envent Engineering technician requests the device file for 
diagnostic purposes. 
 

1. Connect to the device using one of the methods described in Section 3 of this manual. Ensure 
that the device is connected and has been “read” and all parameters are sucessfully in the 
software. The save function only saves the current “read” state of the analyzer. 
 

2. Click the File menu and click “Save As…”, save the device file to a known location and give the 
file a descriptive name. The recommended file format is as follows: “YYYY-MM-DD – 
[SN].device” 

 

2.9 Uploading a Device file to the Analyzer 

It may be required to upload an older (or preconfigured) device file to the analyzer. 
 

1. Connect to the device using one of the methods described in Section 3 of this manual. Ensure 
that the device is connected and has been “read” and all parameters are sucessfully in the 
software. 
 

2. “Close” the current configuration by navigating to File > Close. The user can also right-click the 
device tab (below the menu bar) and click “Close”. Closing the device file this way maintains 
the connection to the device. 
 

3. Open the required configuration file by navigating to File > Open. Select the file needed to be 
opened. 
 

4. Write the opened configuration to the analyzer by clicking the write icon ( ). 
 

2.10 Changing System Units 

Click the View > Preferences menu. This dialogue menu will allow the user to change the time units as 
well as the temperature and pressure units displayed in the ICE software. The recommended time 
units to use are “ss.ss”. 
 
  



Envent Engineering Ltd – 131S & 132S Software Manual – Revision 1  Page 8 
 

2.11 Using the System Variables (Blue Menu) 

System variables are often used for configuration, ranging from setting up alarms to configuring 
modbus or the display of the analyzer. When a field, which can accept system variables, is opened the 
system variables menu will become visible. It is easily identified by its blue color. 
 

 
 

Each system variable can be “dragged” into a field which accepts it. Some fields (such as modbus 
configuration) allow system variables to be double-clicked or even entire folders to be dragged.  
 

1. Identify the variable that is needed and locate it in the folders. 
 

2. Drag the variable into the required field (see screenshot below). To remove variables, the 
variable can often be deleted by highlighting it and pressing the “Delete” key on the 
keyboard. In the example below, a Discrete Input “Low He” was dragged to create a new 
alarm point. 

 
 

Please note: For some variables we must use the “Output Value” of the variable. An example may be 
the oven temperature. The location “Analog Inputs > Oven Temp” is the configuration of the oven 
temperature input and not the actual variable. For this example, the correct variable would be: “GC 
Control > Analog Input > Oven Temp > Output Value”. 
 
Please contact Envent Engineering Ltd. for assistance if required.  
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3.0 Connection Interfaces 

3.1 Connection Via USB 

The model 131S/132S gas chromatograph is supplied with a USB-Mini Type “B” connection interface. 
This interface will be located on the top of the GC below the display (on the model 132S GC) or 
underneath the explosion proof cap below the display (on the model 131S GC). 
 
Ensure that the driver is installed properly; if the driver has been installed properly, the USB device 
should show as a comm port in the device manager of the operating system. In Windows 7, 8, or 10 the 
device manager can be found by navigating to the system’s control panel. For assistance with 
installing the USB driver, contact Envent Support. 
 

1. Connect the USB cable from the PC to the gas chromatograph’s interface. 
 

2. In Envent ICE click the connection globe on the menu bar ( ), select “USB-Speed” and the 
correct communications port (in the screenshot below, COM7 was the selected port). 

 
 

3. Click the read button ( ) and monitor the connection bar at the bottom of the software’s 
interface. The connection bar should indicate which port is open as well as a progress bar 
indicating read progress. Once the connection bar has concluded then the software has 
successfully read the parameters from the device. 
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3.2 Connection Via Ethernet 

The model 131S/132S gas chromatograph is supplied with an Ethernet interface card which can be 
used for connection via the Envent ICE Software or for telemetry purposes via modbus. The 
connection interface port on the ethernet card is a standard 8-pin RJ45 Ethernet connection. All 8 pins 
are required for communication; thus, a standard Category 5 (or greater) cable is recommended.  
 
A connection can be established directly connected to the analyzer, or through a network or sub-
network. The host PC and Envent Analyzer must be on the same sub-network to communicate. The 
default connection parameters are as follows: 
 

IP Address: 192.168.1.105 
Subnet Mask: 255.255.255.0 

Gateway: 192.168.1.1 
Host Name: (Typically SN of the board) 

DNS 0.0.0.0 (Windows 11 only) 
 
 If the default settings are lost, please contact Envent Support for instructions on retrieving the 
settings. 
 

1. Connect the Ethernet cable from the PC to the gas chromatograph’s interface, or connect to 
the same network as the gas chromatograph. Ensure that the PC is in the same sub-network 
range as the gas chromatograph. 
 

2. In Envent ICE click the Network menu and select “Scan Network”, or click “Add New…” if the 
network parameters are already known. After a successful scan, the Network menu will 
display all Envent Analyzers currently connected to the network. 
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3. Click the connection globe on the menu bar ( ), select the correct device (please note: the 
devices in the screenshot may appear different on the user’s machine)(the speed selection at 
the top of this interface does not matter). 

 
 
 

4. Click the read button ( ) and monitor the connection bar at the bottom of the software’s 
interface. The connection bar should indicate which port is open as well as a progress bar 
indicating read progress. Once the connection bar has concluded then the software has 
successfully read the parameters from the device. 
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3.3 Configuration of the Ethernet Interface 

Envent ICE has a built-in system for configuration of the ethernet interface card. This configuration 
should be done with the PC directly connected to the interface card and not through a network 
switch, if possible. 
 

1. Determine the sub-network to which the analyzer is connected, ensure the user’s PC is on the 
same network – even if the device is directly connected. 
 

2. Refer to the previous section to “scan” the network and find the analyzer on the network. 
 

3. In the Network menu, point at the device using the mouse cursor and select the “Edit…” 
option. 

 
 

4. A dialogue menu will open, the new parameters of the network interface card can be 
programmed here, once complete click the “Send Changes” button, this will alter the 
configuration of the card. 

 
 

5. Confirm that the change worked by altering the user’s PC Network configuration to match the 
analyzer and use ICE to “scan” the network (refer to the previous section). 
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4.0 Device Configuration 

Before modifying the factory configuration file, make sure to save it on the 
user’s computer first for future retrieval. If the factory configuration file is 
lost or modified without saving it, a copy is kept in the USB flash drive given 
with the analyzer. Envent Engineering Ltd can also provide a copy. To save 
the configuration file, go to File > Save or Save as. 
 
Make the appropriate changes on the factory configuration file through the 
ICE software. When changes are made, they need to be uploaded to the 
analyzer to overwrite what is currently on it. Click on the ''Write button'' 

( ) and wait until the new configuration is uploaded successfully.  
 

Note that the gas chromatograph relies on parameterization for correct analytical operation. 
Adjusting values without a proper understanding of their function can have consequences including, 
but not limited to, loss of measurement; damage to analytical components; and/or injury or loss of life 
to operators.  
 
Make sure to read, and understand, the contents of this manual fully and consult Envent Engineering 
Ltd. if there are any concerns or doubts to the operation, maintenance, or parameterization of the gas 
chromatograph analyzer. This section will use the following symbols, read, and understand their 
purposes. 
 

  

This symbol indicates that the operation, or parameter change, may cause damage to 
the analytical components, or inadvertently create a potentially dangerous environment 
for the operator. 

  

This symbol indicates that the operation, or parameter change, may cause changes in 
analysis, measurement, and/or outputted values or results.  

   

This symbol indicates that there is a piece of information the operator should know prior 
to continuing. 
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4.1 Hardware 

Layout 

The layout tab shows a diagram of the Electronics Main board. This tab can be 
used to visually identify all components. 
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Inputs 

 
 

Discrete Inputs 

There are 4 discrete inputs available in the gas chromatograph, with an optional 8 
telemetry “soft” points. DI 1 to 4 correspond with the discrete input channels on 
the main board. These inputs are programmed to configure alarm points or 
switching points. The below table describes the configuration of the discrete 
inputs. 

IO Name Input the name of the DI (for example: “Low He”) 
Active State Closed: The DI looks for when the signal is “shorted” and 

outputs a “1” indicating the alarm state 
Open: The DI looks for when the signal is “open” and outputs a 
“1” indicating the alarm state 

 

Analog Inputs 

Analog inputs are critical to the functionality of the gas chromatograph and 
should not be adjusted by the end-user. Adjusting the analog input parameters 
can have serious consequences involving the analytical sensor(s) or the analytical 
oven and its internals. For assistance with analog inputs, contact Envent 
Engineering Ltd. 
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Serial Ports 

The serial port configuration can be used to configure the settings for the 
available two (2) RS485 interfaces, as well as the Ethernet interface, for modbus 
purposes. A description of each parameter in this section is listed below. 

Enable Checkbox to enable or disable the tab selected RS485 port 
Name Assign a name for the RS485 port 
Baud Rate Select connection speed from 1200 – 115200 baud/s 
Framing None, RTU, or ASCII 
Usage Select between user defined modbus, modbus master 

mode, or SIM2251* configuration 
Parity No parity, even parity, or odd parity 
Comm ID Comm ID of the RS485 port, must be unique on the 

network. If this value is set to 0, then Comm ID = Plug ID 
Use 2 Stopbits Check to enable 2 stopbit communication as opposed to 1 
Plug ID When Comm ID or Network Comm ID are set to 0, they use 

the Plug ID instead 
Site ID User-defined ID number to identify different site locations 
Network Comm ID [Ethernet Setting] If the network Comm ID is set to 0, then 

Network Comm ID = Plug ID 
Network Usage [Ethernet Setting] Allows the user to select between user 

defined modbus or SIM2251* output 
* = Sim2251 is a pre-set list of variables and uses the Enron (Daniel mode) output 
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Outputs 

 
 

Discrete Outputs 

The discrete outputs section allows the configuration of the gas chromatograph’s 
8 solenoid controls, 4 relay outputs (for DCS/Control Room alarms or indication), 
8 LEDs (located on the display), and up to 11 telemetry points for other indication 
or control. 

These points are typically configured at the factory and should not be adjusted 
without consultation of Envent Engineering Ltd. Adjusting the solenoid outputs 
may inadvertently affect analyzer operation. 

IO Name Input the name of the DO (for example: “10 PORT”) 
Active State Energized: When the state of the DO is active, the circuitry is 

energized 
De-Energized: When the state of the DO is active, the circuitry is 
de-energized 

 

  



Envent Engineering Ltd – 131S & 132S Software Manual – Revision 1  Page 18 
 

Analog Outputs 

Analog outputs are used when a device must be monitored, or controlled, over a 
pair of conductors. Two 4-20 mA, loop-powered, analog output connections are 
available on the gas chromatograph controller.  

Output Mode Disabled = Output not used 
Control = Output used to control a device 
Signal = Output used for signal (ex: to DCS) 

IO Name The name of the signal (Ex: “Oven Temp”) 
Zero Value to be output at 4 mA 
Span Value to be output at 20 mA 
Factory Zero Factory set, do not adjust 
Factory Span Factory set, do not adjust 
Variable The variable to be output (selected by the blue “variable” 

list to the right 
 
Below is a screenshot showing an example of how a variable has been added to 
Analog Output #1. The variable must be found in the listing on the right first, and 
then can be dragged into the position. 
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4.2 Component Properties 

 
 

Components 

This page includes the physical properties tables for each of the selected 
components in the table. Up to 21 components can be selected from a pre-
defined list by clicking the drop-down in the blank area. 

The values defined here are critical to the output and operation of the gas 
chromatograph. Adjusting these values can have a negative impact on 
measurement. For assistance regarding any changes in components, contact 
Envent Engineering Ltd. 
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4.3 System Events 

 
 

System Events 

The system events page allows the user to configure events for manual / 
automated events to occur. These system events are used elsewhere in the 
configuration (such as User Archives, Stream control/timing, Auto-Calibration). 

Up to 32 events can be added by clicking the drop-down menu for a new event. To 
remove events, highlight the event by clicking its index number (ex: “5 of 32”) and 
press the delete key on the keyboard. To access each event’s additional 
configuration, click the event to highlight it and the white space to the right will 
become a configuration panel. This allows powerful automation to be added to 
the gas chromatograph, see the screenshot below for an example of an Auto-
Calibration config. 

Adjusting the system events can cause the analyzer to stop running sample 
through the analytical oven. If adjustments need to be made, contact Envent 
Engineering Ltd. 
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Settings 

The settings section allows for additional configuration of the Halt, Bypass, and 
Acknowledge system states. See the below tables for details on these states and 
the settings for each. 

Halt System state where the gas chromatograph is idle and 
does not inject any sample 

Bypass This system state is not used in the gas chromatograph 
Acknowledge This system state acknowledges active alarms 
 

Activation Allows the user to select from one of the system events 
(configured above) to activate the system state 

Latch Timeout A timer (in seconds) after which the system state is 
disabled 

Output Controls Allows the system state to also alter the state of one, or 
more, of the discrete outputs 
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4.4 Streams 

 
 

Streams Configuration 

Allows the user to define up to 10 unique streams. These streams can be process 
(customer), calibration, reference, or baseline streams. See the tables, below, for 
a description of each of the sections on this page. 

Stream Name User-defined name (ex: “Sales Gas” or “Sales Cal”) 
Stream Type Process = Process (customer end) stream 

Reference = Calibration standard as an “unknown” 
Calibration = Calibration standard, can adjust calibration 

factors 
Baseline = Can run without sample 

Purge Time [Optional] time to purge the stream before running 
Purge Outputs [Optional] outputs which will be turned on to purge the 

stream 
Valid Run Count [Calibration Only] controls the number of runs the 

calibration will average for the final report 
Components User can select which components are used on the stream 

(defined in Component Properties) 
Normalize Checked = Values are normalized to 100% 

Unchecked = Values are not normalized 
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Base Temperature Temperature at which property calculations are performed 
Base Pressure Pressure at which property calculations are performed 
Equations User can select which property calculations are performed 

on the stream (ISO or GPA) 
 
Adjusting the values on this page can have an impact on the measurement, 
calculations, and output of the gas chromatograph. The user must ensure they 
read and understand each value before adjusting them. Contact Envent 
Engineering Ltd. for assistance. 

4.5 Timed Events 

 
 

Timed Events 

Multiple tables can be configured. Timed events allow the gas chromatograph to 
automatically control the timing of valves, inhibits, filtering, etc to produce a 
proper output and chromatogram. 

The timing is critical to the functionality of the analyzer. Proper care must be 
taken, when adjusting these values, or damage to the valves or analytical 
columns can occur. For assistance with the timed events tables, please contact 
Envent Engineering Ltd.  
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4.6 Components 

 
 

The components page contains parameters and configuration vital to the 
calibration and operation of the gas chromatograph. Adjustment of the values on 
this page will have an impact on the accuracy and reporting of the analyzer. 
Proper care must be taken when making manual adjustments to the calibration 
factors. 

Top Half of Page 

The top half of this page is where the calibration tables and component split 
tables can be defined and configured. See below for a description of each 
configurable field. 

Sensor Defines on which sensor the component will be measured 
Component Drop-down selecting the component, defined in 

Component Properties 
Cal. Gas Units Selectable units which appear on the calibration standard 
Cal. Gas Defines the value which appears on the calibration 

standard 
Response Factor Calibration factor calculated during calibration 
Response Factor 
Deviation 

User defined deviation allowance for determining a 
calibration PASS/FAIL 
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Retention Time Time at which the component appears on a chromatogram 
– determined by calibration 

Retention Time 
Deviation 

User defined deviation allowance for determining a 
calibration PASS/FAIL 

Integration 
Method 

Area = Calculates the concentration based on peak area 
(recommended) 
Height = Calculates concentration based on peak height 
Fixed Area = Fixes the peak area to the last forced 
calibration peak area 
Fixed Height = Fixes the peak height to the last forced 
calibration peak height 

RT Update Calibration = Uses calibration run to update the retention 
time (recommended) 
Analysis = Uses analysis run to update the retention time 
None = Does not update the retention time 

Baseline Removal Drop = Removes the baseline based on the interpolated 
baseline of the curve 
Slope = Removes the baseline based on an estimation of 
the slope of the baseline (recommended) 
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Bottom Half of Page 

 
 

This page is for assigning a stream (configured in the Streams page) to 
components, events, and configurations. At the top of the section, additional tabs 
can be added, each tab is for a stream which is configured independently. 

There is a blank space under the tabs for the user-entered name of the stream. 
Below this point there are several drop-down menus, from left-to-right they are: 
Sensor selection (default is “primary”), timed events table selection, stream 
selection (streams which are set up in the Streams page), and calibration table 
selection. The “Cycle Time” box is the time that the stream will run before 
restarting. 

A space in the bottom-left section of this page is used to configure three different 
properties of the stream. 
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Activation 

 
 

Allows the user to define which system events cause 
the stream to run. The check box activates the event, 
and the number next to the check box allows the 
user to define how many runs the event will do. 
 
The example on the left shows a typical calibration 
configuration, where the manual calibration button 
runs the stream 3 times. There is also an interval to 
calibrate daily at 8 AM; again, running 3 times. 

Telemetry 

 
 

The telemetry section allows the user to define 
telemetry for the stream. When the stream is 
running, the selected discrete outputs will be active. 
 
In the example to the left, the CAL-1 LED has been 
checked which will illuminate the CAL-1 LED when 
the calibration stream is running. 

Lockouts 

 
 

Lockouts allow the user to specify when to allow the 
stream to run and when to lock it out. When the 
Lockouts menu is clicked, the blue device register 
menu opens on the right-side of the software. 
 
An example of a low-helium lockout can be seen to 
the left. 

 

  



Envent Engineering Ltd – 131S & 132S Software Manual – Revision 1  Page 28 
 

 
Components 

The components section specifies which component in the stream is tied to which 
component in the calibration tables. This is important to define, as there may be 
multiple components with the same name, but with different calibration standard 
values – in the case of an analyzer with multiple streams and multiple 
calibrations, as seen in the example below. 

 

  



Envent Engineering Ltd – 131S & 132S Software Manual – Revision 1  Page 29 
 

4.7 Calculation Logic 

 
 

The calculation logic page allows the user to create custom calculations which 
can be performed at a specified interval.  

A calculation is created, in the factory, to control the oven temperature. Please do 
not adjust any variables on the Heater PID control calculation or significant, and 
irreparable, damage may occur to the analytical components of the gas 
chromatograph. 
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4.8 Periodic Samples 

 
 

Periodic Samples 

This page allows the user to set up periodic averaged samples. Up to 64 
calculations can be made. Once these variables are created, they can be used 
elsewhere in the software for display, alarm points, outputs, etc. 

Variable User can select the variable on which an averaging 
calculation should be performed 

Activation Select a system event which will begin the averaging 
Reset Select a system event which will stop the averaging – 

default is “No Reset” 
 
An example is shown below which averages the Board Temperature (°C) on a 
minute-by-minute basis, resetting daily at 8:00 AM. 
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4.9 Alarms 

 
 

Alarms 

The alarms page allows the user to define points which will trigger certain states. 
These states may be software or hardware discrete outputs. The table below 
describes the functionality of each column. 

Variable Variable which is selected from the System Variables on the 
right 

Label User-defined label for display purposes 
Sense Mode Determines whether the alarm is ascending or descending 
Setpoint User-defined setpoint for the alarm 
Reset User-defined reset point for the alarm 
Deadband Absolute difference between set and reset points 
Latch Checked = Alarm will remain until acknowledged 

Unchecked = Alarm will clear when the state clears 
Output Controls Select which discrete outputs are changed when the alarm 

state is true 
Alarm On Timer Allows a “grace period” before the alarm is activated 
Alarm Off Timer Allows a “grace period” before the alarm is deactivated 
AO Effect None = Alarm has no effect on Analog Output 

Full Scale = When in alarm state, AO goes to 20 mA 
Below Zero = When in alarm state, AO goes to 3.5 mA 
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4.10 Display 

 
 

Left Section 

 

The left section of this page allows the user to define which variables will appear 
on the display. 

Caption User-defined display name of the variable 
Variable Variable selected from the System Variables on the right 
Units User-defined engineering units of the variable 
Decimals User-defined number of decimals to use 
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Right Section 

 

The right section of the page allows for additional configuration of the display. 
Including the ability to cause the LEDs to blink rather than remain solid when they 
are illuminated. 

LED Blink Hz Allows the user to set a frequency for the button to 
blink rather than remain solid 

Backlite Timeout (Sec) Timeout for the back lighting of the display 
Menu Timeout (Sec) Timeout for the additional menu of the display 
Layout Type Allows the user to select between 1-line to 4-line 

display 
Top Button Function Bypass = Top button makes the analyzer go into 

bypass (not used on GC) 
Halt = Top button halts the GC 
Acknowledge = Top button acknowledges all alarms 
Disable = Top button does nothing 

[Bottom Left Area] A system variable can be “dragged” to this location for 
view in the extra space on the display (bottom-right of 
the display) 

Units Text Text to appear, as units, for the extra space on the 
display (bottom-right of the display) 
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4.11 User Archives (Configuration) 

 
 

The user archives page allows for the analyzer to record lists of variables in its 
internal memory for reporting / recall later. The display indicates the amount of 
memory, which is being reserved for archives, as well as the amount remaining. 
The lower section is for user-configuration. 

Items 

 

When items are added from the System Variables, they 
appear in a list format here. Multiple lists can be added 
into the Items column. Groups of variables are treated 
as a group, or array. 

Archive Name User-defined name for the archive to appear on 
reports. 

Rollover Count The number of records before the archive is rolled 
over. First in, first out. 

Activation The user can define which System Events cause the 
analyzer to record an archive count. Example: Interval 
at 1 minute, or End of Analysis. 
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4.12 User Modbus 

 
 

The user modbus page allows for user-defined modbus variables to be output on 
all modbus channels. There are multiple register types that can be configured. 
Variables must be “dragged” from the System Variables interface on the right side 
of the screen (variables can also be double-clicked to add them to the modbus 
table). A default modbus (32-bit) configuration is supplied with every GC analyzer. 

 

Above the configurable table there are three selectable modbus options. 

Enron Also known as “Daniel” mode. Uses 32-bit registers 
Modicon16 Switches the registers to 16-bit registers 
Modicon32 Switches the registers to 32-bit registers 
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5.0 Chromatograph Reporting 

5.1 Calibration 

 
 

Calibration reports are generated using this page. When the page is opened, it will 
be blank. To generate a report, select the number of reports required (in the text 
box) and click the “From Analyzer” button. 

There are additional options on the calibration report page. 

Open Opens a report which was saved from the “save” function 
Save Saves the currently open report in a format only readable by 

ICE 
Print Preview Opens the Windows print dialogue 
Clipboard Copies the report to a tab-separated format for pasting into 

Excel 
From Analyzer Clicking this button pulls reports from the analyzer 
Table #[x] A drop-down menu to select which calibration table to pull 

reports from (calibration tables are configured in the 
Components page under Configuration) 
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5.2 Analysis 

 
 

This page allows the user to generate analysis reports. The analysis report 
contains the raw and analytical data for analytical runs. 

Load Report Loads a report saved in an ICE format 
From Chart Parses data from a chromatogram (.chart) file into a report 
From Analyzer Downloads the selected number of reports from the analyzer 
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5.3 User Archives (Reports) 

 
 

The user archives page is split into two sections. The top section allows the user 
to define which user-defined archives to retrieve and how many. The bottom 
section displays the information along with some buttons to control the data. 

Top Section 

The top section contains two text boxes, the first text box is to offset the records 
and the second is to indicate how many records to retrieve. For example, if 20 “# 
of records” is selected, the analyzer will send the previous 20 records; if an offset 
of 1 is entered, the analyzer will send 20 previous records beginning with the 2nd 
most previous. The “Read Archive Records” button begins the operation, the 
“Abort” button stops the operation. There is a progress bar for indication.  

Below the progress bar are several tabs, the number of tabs appearing here 
depends on the configuration for the user archives. The “Read Archive Records” 
button must be pressed for each tab to retrieve data from each. 
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Bottom Section 

The bottom section contains all the information that was retrieved from the 
analyzer’s internal memory. There are several buttons available in this section 
once data has been generated.  

Select All Clicking this button selects all the currently viewed data 
records 

De-select All Clicking this button de-selects all the currently viewed data 
records 

Copy To Clipboard Clicking this button copies the selected data to the 
clipboard, as a tab-separated format, for pasting into Excel 

Auto Fit Clicking this button automatically re-sizes all the data 
views to fit the information 

 

Additional to the buttons, there is also an option to filter the data based on a date 
range. Each column can also be filtered based on “largest to smallest” or 
“smallest to largest” by clicking the column headers. 

5.4 Change Log / Maintenance Log 

The change log page is used to view any changes that the firmware has recorded. 

The maintenance log page allows the user to upload custom notes to the analyzer 
and retrieve the loaded notes. 
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6.0 GC Operations 

6.1 GC Control 

 
 
System IO Dashboard 

The system IO Dashboard allows the user to view live data from all the 
inputs/outputs of the device. At the top is the real-time clock, board temperature, 
and the state of the 8 LEDs. Followed by three “speedometer” graphics indicating 
the analog inputs and an array of boxes indicating the discrete inputs. At the 
middle of the page are two bar graphs indicating the analog output readings, as 
well as a vertical graph indicating the frequency output reading. The bottom of 
the page has an array of boxes indicating all the discrete output states. 

Right clicking the discrete outputs allows the user to manually change the state of 
the outputs or switch the outputs back to automatic control. 

Please note, manually changing the state of discrete outputs may have an impact 
on measurement. There is no timeout or safety feature to prevent incorrect 
operation of the valves using this feature. Ensure outputs are back in Auto mode 
before continuing measurement. 
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Enunciator Dashboard 

The second tab of the GC Control page allows the user to see the state of alarms 
and active states of the analyzer. 

  



Envent Engineering Ltd – 131S & 132S Software Manual – Revision 1  Page 42 
 

 
 
Analysis Sequence Dashboard 

This view allows the user to see the sequence of analysis events to occur. The 
elements on the left side of the screen are buttons with two distinct functions. 

 

Clicking the body of the button (gray area) will queue up the stream in the 
analysis sequence according to the “Manual” system event for that stream 
(defined in the Components page of Configuration). Clicking the “Continuous” 
checkbox will queue up the stream in the analysis sequence but will run 
indefinitely until the checkbox is unchecked. 

The “Abort Current Run” button (at the top) will immediately cancel the analysis, 
regardless of the timing of the run, and put the analyzer into idle mode. Extreme 
caution must be taken when using this button, as it can harm the operation of the 
analyzer since components are at an unknown position in the analytical 
columns/valves when the button is pressed. 
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Below the stream timer the analysis sequence can be found. The analysis 
sequence shows which streams will be run after the current stream has finished. 
At the bottom of the page are the control buttons, the table below describes the 
function of each. 

Run Analysis Sequence Starts the GC and runs the current sequence 
Reset Analysis Sequence Resets the analysis sequence to the default state 
Halt Halts the GC after the current run is finished 
Run Brings the GC out of idle mode and runs the current 

analysis – this button also cancels a halt request 
Clear Alarm Latches Clears all latched alarms if they are out of alarm state 
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6.2 Chromatogram 

 
 
The chromatogram page allows the user to view live or archived chromatograms 
and all related analytical data. 

The main viewer takes up the bulk of the page, with navigational and control 
buttons at the bottom of the view. 

There are some intuitive controls to navigate the chromatogram viewer. The 
chromatogram can be dragged around by holding left-click and moving the 
mouse. When the right-click button is held and the mouse is moved, a box is 
drawn to zoom in on a desired portion of the chromatogram. Double-left-click 
recenters the view and resets the scaling to the default scale.  

Right-clicking anywhere on the chromatogram brings up the context menu for 
more operations including the ability to convert the chromatogram into an 
Analysis Report, performing a forced calibration, and turning individual traces 
on/off (in the case of a multiple detector analyzer). 

The table on the next page goes over the controls at the bottom of the 
chromatogram page. 
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Controls that navigate the viewer between previous and next 
chromatograms. The timestamp indicates the currently 
viewed chromatogram 

 

Clicking this button brings up the archive dialogue box, the 
user can double-click to select a chromatogram to view, from 
the analyzer’s internal archive 

 

The File button allows the user to open a previously saved 
chromatogram (.chart) file. Clicking the arrow next to the icon 
brings up additional options to save the chromatogram file 

 

Begins recording live chromatograms to the PC’s internal 
memory. If they are not saved using the file dialogue they are 
lost forever when closed 

 

Starts the software playing the live chromatogram from the 
analyzer as it appears real-time 

 

The Cal. Button enters the currently viewed chromatogram 
into calibration mode. Which enables more features. 

 

Clicking the Popups button enables contextual popups on the 
chromatogram – indicating some data about peaks and 
timed events when the mouse cursor is pointed at them 

 

Best Fit automatically scales the view of the chromatogram to 
the height of the largest peak visible on the screen at the time 
the button is pressed 

 

Shows the comment box for the currently viewed 
chromatogram 

 

Resets the view to the default view (largest peak scaling) 
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6.3 Calibration 

Calibration should be performed on the Gas Chromatograph at intervals specified in the User’s 
Manual. This section does not cover individual calibration configuration and only covers the 
calibration methods within the software. For more information on setting up the hardware for 
calibration, refer to the Gas Chromatograph user’s manual. 
 
There are three calibration modes: Automatic calibration, manual calibration, and forced calibration. 
From the factory, calibration is designed to run 3 times and compare the last 2 runs. 
 
 

Ensure that the correct pressure / flow is set up for the calibration stream that 
needs verification / calibration. Calibration involves adjusting measurement 
sensitive factors in the analyzer and will have an impact on the performance and 
output of the analyzer.  

6.3.1 Automatic Calibration 

The gas chromatograph can be programmed to run the calibration on a regular basis, automatically. 
The following steps outline the general procedure for setting up automatic calibration. Typically, the 
analyzer is configured from the factory. For assistance, contact Envent Engineering Ltd. 
 

1. Create a system event (if one is not already in use) for the interval required, the example in the 
screenshot has an interval Daily at 8:00 AM 

 
 

2. On the Components page, ensure the proper calibration stream is selected, check the new 
interval in Activation, and set the number of runs to 3 
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3. Automatic calibration is configured once written to the analyzer and will run on the interval 
specified 
 

4. The calibration will automatically do 3 runs at the specified interval and generate a calibration 
report when finished. If the calibration is a pass, the calibration factors will be updated, if it is 
a failure, they will not be updated 
 

5. Calibration reports can be pulled from the analyzer as required 
 

6.3.2 Manual Calibration 

If the analyzer is not equipped with automatic calibration or a manual calibration is desired, follow 
these steps. 
 

1. Navigate to the GC Control page under Operations 
 

2. Click the gray button for the calibration stream that needs to be run, this will queue the 
calibration to be run next – do not click the Continuous check box, that is for forced 
calibration 

 
 

3. The calibration automatically does 3 runs and generates a calibration report when finished. If 
the calibration is a pass, the calibration factors will be updated, if it is a failure, they will not be 
updated 
 

4. Navigate to the Components screen (Configuration > Components) and read from the device 

( ) to ensure that the Response Factors update 
 

5. Calibration reports can be pulled from the analyzer as required 
 

  



Envent Engineering Ltd – 131S & 132S Software Manual – Revision 1  Page 48 
 

6.3.3 Forced Calibration 

During start-up, or when large hardware changes have been made (such as different valves, columns, 
or calibration standard), the deviation may be too large for an automatic / manual calibration to 
properly calibrate the analyzer. In these situations, a forced calibration may be necessary. 
 

 
Please note, a forced calibration is not a solution for poor chromatography. If 
there is an analytical problem such as, but not restricted to, lack of carrier 
pressure, poor calibration standard, damaged valves, damaged columns, or a 
damaged sensor, then the analytical problem must be remedied before a proper 
calibration can take place. A forced calibration will not fix an analytical hardware 
error. 

General Forced Calibration Process 

The process for a forced calibration is as follows: 
 Run calibration standard continuously, until chromatograms are stable 
 Verify stability of chromatograms 
 Verify the positioning of each of the peaks 
 Select one chromatogram and enter calibration mode 
 Force the calibration factors from the chromatogram into the calibration table 
 Write the calibration factors to the analyzer 

 
Steps 

Follow the steps below to perform a forced calibration. 
 

1. Navigate to the GC Control page under Operations and engage the “Continuous” check box for 
the calibration stream. This will run the stream indefinitely until the box is unchecked. 

 
 

2. Navigate to the Chromatogram page under Operations and either 
a. Pull chromatograms from the archive as they finish (recommended) – click the 

“Archives” button and the calibration runs should appear at the top of the dialogue 
box. Pay special attention to the time stamps 

b. Begin trending Live Chromatograms by clicking the “Live CGM” button, and record 
them to the PC’s memory by clicking the “Record” button 
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3. Verify chromatogram stability after 5 or 6 runs.  
[OPTIONAL] The most effective method to do this is to record 5 or 6 chromatograms to the 
viewer, then navigate to View > Preferences, and change the viewer to “Stacked” in the Chart 
Options. This will stack all the chromatograms, making any differences in them stand out 

 
 

The screenshot below shows what 5 stacked, and stable, chromatograms could look like. If 
there are any significant variations between the runs, then there is likely a hardware problem 
Note: the actual chromatogram depicted may be different depending on the analyzer 

 
 

4. If the chromatograms are stable, continue. If the chromatograms are not stable, contact 
Envent Engineering Ltd. as more troubleshooting is likely required 
 

5. Switch the view back to single chromatograms by navigating to View > Preferences and switch 
the chart options back to “Single Frame”, if required. This makes it easier to work on the 
chromatogram 
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6. Identify, and confirm, the position of each of the component peaks on the chromatogram. The 
retention time (RT) of each peak should be close (but does not need to be exact) to the value 
listed in the calibration table on the Components page. If needed, make small adjustments to 
the retention time of each peak’s location. The operator must ensure they have properly 
identified each peak which eluted, and the order that they were detected 
 
Prior to making any severe adjustments to the Retention Times, contact Envent Engineering 
Ltd. 

 

7. Select one of the stable chromatograms and enter calibration mode by clicking the “Cal.” 
Button on the toolbar at the bottom of the screen. An interactive system will open showing all 
the timed events, right-click the chromatogram and click “Forced Cal.” Read and acknowledge 
the dialogue box that pops up to allow the forced calibration to take place 
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THE ANALYZER IS NOT YET CALIBRATED. The calibration factors have been forced into the 
calibration table 
 

8. Write the calibration factors into the analyzer by clicking the write ( ) button 
 

9. Take the analyzer out of continuous mode by unchecking the “Continuous” check box on the 
GC Control page 

 
 

10. Perform a manual calibration, if desired, to ensure the analyzer has properly calibrated 
 

11. Calibration reports can be pulled from the analyzer as required 
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Contact Us  

In the event that a situation arises that is not covered by this manual, we encourage you to contact us 
so that we can help you resolve any issues you may have. Please have this manual readily available 
when calling for assistance. 
 
For further information on our products or to access our most recently updated manuals and product 
catalogues, please visit our website at www.enventengineering.com. 
 
Canada (Main) 
 
Toll Free: 1 (877) 936 – 8368 
Tel: (403) 253-4012 
Fax: (403) 253 -4016  
Email: info@envent-eng.com 

 
USA 
 
Tel: 1 (713) 567 – 4421 
 
 

 
 
China 
 
Tel: 86 (138) 0119 – 1148 
 

 
 
 
 
 

 


